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1. Getting Started

1.1 About Quick Start Guide

The Quick Start Guide helps you get to know GMG SmartProfiler. After you have completed the tutorial,
you can start printing right away. You will notice the difference—consistent colors, excellent print quality
and production stability.

In this tutorial, you will learn the procedures listed in the following table. If different personnel are respon-
sible for different workstations, it might make sense to distribute the information according to the work-
station it is referring to.

Tip Print this page and checkmark all finished steps in the OK column in order to keep track of the prog-
ress.

OK Workstation Required steps See also

Frontend Make a pre-check of the printing system to confirm that it is supported by GMG Smart-
Profiler and that it is in good condition.

"Pre-check of the
Printing System"
on page 8

All Set up the computer hardware and install all required software components. "Additional
Requirements
under Windows 7
and Windows
Vista" on page 14

Server Create an input folder for the printer frontend (RIP).

Client Configure the server from a client: Create a virtual printer–medium combination and con-
nect GMG ColorServer to the frontend RIP.

"Starting GMG
SmartProfiler" on
page 20

Server Use hotfolders for automated printing procedures. "Choosing a
Printer–Medium
Combination" on
page 27

Client Recalibrate a printer. "Recalibration" on
page 30

1.2 Welcome to GMG ColorServer Suite

1.2.1 Large Format and Digital Printing

The products GMG ColorServer Digital and GMG SmartProfiler form an ideal combination for Digital and
Large Format Printing.

In addition to the general benefits of GMG ColorServer, this product combination offers the following
advantages.

Reproducible colors: Standardize your print production, within tolerances defined for standard color
spaces such as Fogra39.

Color consistency between different devices: Achieve color matching results across a diversity of sub-
strates, ink types, printing technology, and industry standards.

Flexibility and load balancing: Choose the output device according to your production requirements.
Don't worry about color results.

Especially useful for mixed production environments

GMG SmartProfiler will safely and quickly guide you through the process of profiling your printing
system.
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1.2.2 GMG ColorServer Suite Workflow

GMG ColorServer Suite comprising GMG ColorServer Digital and GMG SmartProfiler is a full-featured
automated system ensuring an excellent print quality and production stability in a digital printing or large
format production environment.

All benefits are wrapped up in one easy-to-use system. You will be guided through all required processes
step-by-step. GMG ColorServer Suite is an ideal solution for smaller and larger workgroups, thanks to its
client-server architecture.

Fig. 1 Workflow diagram illustrating the process chain.

No. Description

1 RGB and CMYK input data from multiple sources are collected for processing with GMG ColorServer.

2 You can easily submit jobs from any standard browser on any platform such as Windows or Mac OS.

3 Submitted jobs will be automatically uploaded to a web server running GMG WebConnect. The web server can be installed on
the same computer as GMG ColorServer or on a different computer, as shown in the above illustration. The web server will dis-
tribute incoming jobs to hotfolders on the GMG ColorServer system.

4 Input documents are converted to PDF and optimized for the target printer by GMG ColorServer.

5 Normalized CMYK data is then sent to a printer from the printer pool via the output folder.

6 GMG SmartProfiler is used to profile the printer–medium combination and to recalibrate it on a regular basis by printing and
measuring test charts.

The individual components of the software package are described in the following.

GMG ColorServer

The central core module of GMG ColorServer processes input documents and performs high-quality color
management. The technology is hotfolder based: You only need to copy the document into a hotfolder—
the processing is started fully automatically. Output PDFs can be directly sent to the printer. GMG Col-
orServer will be installed on a central server so that hotfolders can be accessed from multiple work-
stations.

Files from different or unknown sources are normalized to a common color space according to the tar-
get printing condition ISO Coated v2 (39L) or GRACoL.

PDFs are flattened and optimized for achieving premium print results.

Colors are optimized specifically for the used printer–medium combination, that is, for a specific
printer and print medium, a specific ink type and print mode.
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GMG SmartProfiler

You can set up and maintain the hotfolder configuration from multiple client computers in the network, by
using GMG SmartProfiler.

GMG SmartProfiler has a wizard-like structure enabling any user to easily calibrate, recalibrate, and pro-
file compatible printing systems without requiring any in-depth knowledge of color management.

Create a hotfolder configuration for all printer–medium combinations you might use.

Recalibrate printer–medium combinations on a regular basis to ensure reproducible colors and to
counterbalance undesired printer deviations caused by varying environment conditions such as tem-
perature and humidity.

GMG WebConnect

With GMG WebConnect, which is included in GMG ColorServer Suite, you can set up client users for sub-
mitting jobs from a browser. Client users do not need to install GMG WebConnect and just need a stand-
ard web browser to access the web server and create and track jobs from anywhere in the world.
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2. Pre-check of the Printing System
The main reason for using GMG ColorServer Suite in a digital or large format production environment is to
achieve a reliable and consistent color reproduction, as described in detail in the "Welcome" chapter.

"Consistent" does not mean a better quality, does it?

Yes—and No. Of course, if you want to achieve consistent colors on different printing systems, the quality
is somehow limited by the weakest system you might have.

However, you will experience that GMG ColorServer Suite can dramatically increase your print quality by
flattening and normalizing documents and by applying high-quality color management. To get you an
idea of what we are talking about, here is a short summary of what is possible.

Avoid overinking

Perfectly smooth gradients

Print deep, dark color tones to bring out detail in the shadows

Print bright and colorful images

Avoid unintended tints or color drifts

However, there are technical limitations you should be aware of before starting to work with GMG Col-
orServer Suite. For example, if the ink is running from the print medium, if a "gradient" prints as a full
tone, or if you observe very strong print artifacts, there is not much you can do about it by profiling alone.

To save valuable time and resources, we therefore highly recommend a pre-check of the printing system
before starting the profiling process.

The pre-check described in this chapter has the following goal.

Confirmation that the printing system is in general supported by GMG SmartProfiler.

Confirmation that the printing system is in good shape and that it will be possible to achieve a good
printing quality on the system.

Confirmation that the settings of the frontend RIP are compatible with GMG SmartProfiler.

Test charts specifically designed for a pre-check of digital and large format printers have been developed
by GMG ColorExperts. They are provided together with the software and are described in detail in sep-
arate chapters.

If the pre-check results fulfill the minimum quality criteria, you can proceed with the profiling.

If the results are not acceptable, you will need a technical service before you can proceed with the
profiling.

If the results are far away from acceptance or if the technical service does not solve the problems,
you can consider the printer as not supported by GMG SmartProfiler.

Note Do not proceed with the profiling before you have solved all issues and performed a successful pre-
check.

2.0.1 How to perform the pre-check

1. Make sure the frontend and the printing system is in the status you currently use for production.

2. Print the appropriate test charts directly on the printer–medium combination you want to profile, with-
out using GMG SmartProfiler and GMG ColorServer.

3. Visually assess the print quality.

See also:

l "Visual Evaluation of the Print Quality" on page 9

l "Digital Printers" on page 10

l "Large Format Printers" on page 11

../../../../../Content/GMG_Text/SmartProfiler/Getting Started/Welcome SP.htm
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2.1 Frontend Requirements

The printer frontend you want to create printer calibrations or profiles for must meet the following require-
ments to be compatible with GMG SmartProfiler.

Automated print workflow: Our hotfolder technology allows supporting all kind of printers and digital
presses independent of the used printer driver, frontend RIP, and so on. For an automated printing of test
chart pages created by GMG SmartProfiler, however, the frontend needs to support an automatic printing
from input folders. Of course, you can also manually print the test chart pages.

PDF support: If you want to calibrate or profile PDF hotfolders, the frontend needs to support PDF version
1.3.

2.2 Visual Evaluation of the Print Quality

You can print a test chart to visually check the print quality.

We recommend this check for two purposes:

Before profiling:

Printer and frontend RIP: Use your standard print and RIP settings.

Printer only: Deactivate the color management and linearization of the frontend RIP. This will
be the basis for the profiling process with GMG SmartProfiler.

After profiling: As a final approval of the profile and to document the profile quality for later ref-
erence.

2.2.1Where to find the test chart

<installation path>AppData/Charts/Visual_Profile_Check\GMG_TestForm_visual_<version No.><printer
type><orientation>.pdf

Fig. 2 Visual test chart.

All test objects are numbered on the chart. You will find a detailed explanation for all objects in the fol-
lowing table.
No.Object Description

1 Register
marks

There are four register marks in each corner of the test chart to control the color register. The color
register determines the overlay of the different printing colors in the printing process. If the color reg-
ister is not correctly adjusted, the register marks will appear blurred or slightly shifted. By arranging
the register marks in groups of four, the test chart enables you to determine whether the color reg-
ister is prone to variations across the sheet.

2 Color den-
sity bars

Solid bars in the primary colors to determine whether a stable color tone is printed across the sheet.

3 GMG Uni-
fied Control
Wedge

Measure the control strips (ISO Coated v2 (39L) from FOGRA on the left side, GRACoL on the right
side) to determine whether the measured color values are within the tolerances as defined by ISO
standards.

4 Memory
bars

The memory bars have to be assessed with an eye to the gray 4c background. "Printer Main-
tenance"

../../../../../Content/GMG_Text/SmartProfiler/Printer/Printer Maintenance.htm
../../../../../Content/GMG_Text/SmartProfiler/Printer/Printer Maintenance.htm
../../../../../Content/GMG_Text/SmartProfiler/Printer/Printer Maintenance.htm
../../../../../Content/GMG_Text/SmartProfiler/Printer/Printer Maintenance.htm
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No.Object Description

If you can see shadow images of the bars on the background, this could mean that the print heads
need to be cleaned. If this is the case, the printer status might not be suitable for profiling. Please per-
form any necessary printer maintenance actions, reset GMG SmartProfiler, and restart the profiling
process.

5 Test images Test images with a lot of detail and mixed colors are used to visually assess the profile quality.

6–
7

Gradations The gradations reflect the smallest printable dot. Furthermore, you can check the linearity of your
printing system. If the gradations show any breaks, the printer linearization might not be sufficient.

The gradations will also reveal gradation breaks or solarizations that might be caused by the profile.

The gray gradation strips can be used to evaluate the neutral gray.

"Ink Limit
and Lin-
earization"

8 Grayscale
images

Grayscale images reflect the selected separation settings. You can use the images to check the gray bal-
ance.

"Separation
Settings"

9 Overinking For evaluating the ink limit and overinking. "Evaluating
the Ink Limit"

10 CMYK back-
ground

The gray 4c background serves to evaluate the homogeneity of the print. Attention should be paid to
an overall smoothness of the background. There should be no color shifts or banding.

If you can see shadow images of the GMG Unified Control Wedge control strips on the background,
this could mean that the print heads need to be cleaned. If this is the case, the printer status might
not be suitable for profiling.

"Printer Main-
tenance"

11 Overprinting
CMYK, RGB

(PDF only) If the object shows a clear overprinting of the primary colors, the overprinting parameter
in the printer frontend is set correctly.

"Frontend"

12 Siemens
stars

(PDF only) Siemens stars are a very useful pattern to check the resolution of a printer. The pie-shaped
bright spokes of the stars on a dark background become narrower towards the center of the star. The
higher the resolution of the printer, the closer to the center of the star they will appear to merge.
Comparing the test chart to recent reference prints can help to detect any printer deviations. Artifacts
at the border of the stars are an indication of a frontend optimization. Such an optimization has a det-
rimental effect when it comes to printing characterization charts and might negatively affect the pro-
file quality.

"Frontend"

13 Type (PDF only) Type reveals any font or color replacement in the printer frontend. It also reveals whether
the printer frontend applies anti-aliasing or not. Anti-aliasing might negatively affect the profile qual-
ity. Test charts should be printed without anti-aliasing.

"Frontend"

14 Strokes (PDF only) Strokes with different weights are used to check the print resolution. Comparing the test
chart to recent reference prints can help to detect any printer deviations. If strokes with the same
weight appear to be different with respect to the dark or light background they are printed on, this
might be caused by frontend parameters. This might falsify measurement results and thus negatively
affect the profile quality.

"Frontend"

2.3 Digital Printers

The pre-check described in the following applies to inkjet and laser/toner digital printers.

During this test, you will print a 5-page test chart for a visual evaluation of the print quality.

4 c gray area (C40 M40 Y40 K40) with fulltone patches (C100 M100 Y100 K100)

1 c gray area (C0 M0 Y0 K40) with fulltone patches (C0 M0 Y0 K100)

1 c Cyan area (C40 M0 Y0 K0) with fulltone patches (C100 M0 Y0 K0)

1 c Magenta area (C0 M40 Y0 K0) with fulltone patches (C0 M40 Y0 K0)

1 c Yellow area (C0 M0 Y40 K0) with fulltone patches (C0 M40 Y0 K0)

Where to find the test chart

<installation path>AppData/Charts/Visual_Lin-Inkcut_Check\GMG_DP_Test_Form_technical_<version
No.>.pdf

../../../../../Content/GMG_Text/SmartProfiler/Ink Limit/Ink Limit and Linearization.htm
../../../../../Content/GMG_Text/SmartProfiler/Ink Limit/Ink Limit and Linearization.htm
../../../../../Content/GMG_Text/SmartProfiler/Ink Limit/Ink Limit and Linearization.htm
../../../../../Content/GMG_Text/SmartProfiler/Ink Limit/Ink Limit and Linearization.htm
../../../../../Content/GMG_Text/SmartProfiler/Ink Limit/Ink Limit and Linearization.htm
../../../../../Content/GMG_Text/SmartProfiler/Ink Limit/Ink Limit and Linearization.htm
../../../../../Content/GMG_Text/SmartProfiler/MX4/Separation Modes.htm
../../../../../Content/GMG_Text/SmartProfiler/MX4/Separation Modes.htm
../../../../../Content/GMG_Text/SmartProfiler/Ink Limit/Evaluating the Ink Limit.htm
../../../../../Content/GMG_Text/SmartProfiler/Ink Limit/Evaluating the Ink Limit.htm
../../../../../Content/GMG_Text/SmartProfiler/Ink Limit/Evaluating the Ink Limit.htm
../../../../../Content/GMG_Text/SmartProfiler/Ink Limit/Evaluating the Ink Limit.htm
../../../../../Content/GMG_Text/SmartProfiler/Printer/Printer Maintenance.htm
../../../../../Content/GMG_Text/SmartProfiler/Printer/Printer Maintenance.htm
../../../../../Content/GMG_Text/SmartProfiler/Printer/Printer Maintenance.htm
../../../../../Content/GMG_Text/SmartProfiler/Printer/Printer Maintenance.htm
../../../../../Content/GMG_Text/SmartProfiler/Printer/Frontend.htm
../../../../../Content/GMG_Text/SmartProfiler/Printer/Frontend.htm
../../../../../Content/GMG_Text/SmartProfiler/Printer/Frontend.htm
../../../../../Content/GMG_Text/SmartProfiler/Printer/Frontend.htm


GMG SmartProfiler Digital Printing + LFP—Quick Start Guide

11 / 32

Expected results

The area should show a homogenous print result.

The fulltone patches should have a sharp border.

What to look for

Color shifts or inhomogeneities

Massive overinking (slight overinking can be come by with profiling)

Hair lines

Printer streaks

Streaks or artifacts in a regular pattern, especially when printing on flexible foils

Ghosting (a double image, which can be a positive or negative image of the fulltone patches)

Blushing (lighter or darker color) around the fulltone patches

The 1 c test charts might help you to narrow down the problems you might find. For example, you can see
whether the problem is a general system failure and occurs with all inks or whether the problem can be
narrowed down to a particular ink.

2.4 Large Format Printers

The pre-check described in the following applies to inkjet or solvent-based large format printers.

During this test, you will print a 1-page test chart for a visual evaluation of the print quality. If the print-
able area of your printer does not support the full size of the chart, you can use the dotted lines on the
chart to tile the page.

The test chart has three functional parts:

4 c gray area (C40 M40 Y40 K40) with fulltone patches (C100 M100 Y100 K100)

Gradations with pure colors, plus an additional color

Gradations with pure colors

2.4.1 4c Gray

Expected results

The area should show a homogenous print result.

The 1c gray gradation strip should show a neutral gray without a tint.

What to look for

Color shifts or inhomogeneities

Massive overinking (slight overinking can be come by with profiling)

Hair lines

Printer streaks

Streaks or artifacts in a regular pattern, especially when printing on flexible foils
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2.4.2 Gradations with pure colors, plus an additional color

From top to bottom, the gradations start with pure colors (1c, 2c, or 3c as indicated on the test chart). From
bottom to top, an additional color is gradually added, as indicated by the "+" on the test chart.

The color that is furthest down on the chart is a 3c full tone (C100 M100 Y100 K0), which can be used as
an indicator for overinking.

The gray gradation strip on the right can be used to evaluate the neutral gray.

2.4.3 Gradations with pure colors, without an additional color.

Where to find the test chart

<installation path>AppData/Charts/Visual_Lin-Inkcut_Check\GMG_LFP_Test_Form_technical_<version
No.>.pdf

Expected results

The gradations should be smooth without any visible breaks.

When using a solvent-based printer, you might need to optimize the drying temperature during the pre-
check process.

What to look for

Massive overinking (slight overinking can be come by with profiling)

Massive visible breaks in the gradations (minor breaks can be come by with profiling)

Grainy colors

Strong artifacts
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3. Program Installation

3.1 Installation Overview

GMG ColorServer Suite comes with several components you can select in the feature list of the instal-
lation wizard. The following table will provide you with information on the different components followed
by a description of the possible client/server structures.

Feature/Component Description

ColorServer Main color management application.

ConnectManager GMG ConnectManager is a utility program that monitors all GMG Connect components.

ConnectServer Part of the GMG Connect system that links GMG applications such as GMG ColorServer and GMG Smart-
Profiler or GMG WebConnect across different computers. Central data management of the Connect sys-
tem, needs to be run in the background.

Ink Saving Report Tool Tool that analyzes your output and calculates the ink savings you could realize with GMG InkOptimizer.

SmartProfiler Calibration and profiling wizard. GMG SmartProfiler can also be installed as a client component on a dif-
ferent computer for information exchange with GMG ColorServer via your local network.

WebConnect Server Web server for remote data management that allows to set up users for remote use of GMG ColorServer
hotfolders.

3.1.1 Client/Server configuration possibilities

All components of GMG ColorServer Suite can either be installed on one system and used just locally or
distributed across several computers, allowing for a networked, but centrally controllable cross-platform
color management. For example, you can install GMG SmartProfiler on several computers within your net-
work and create hotfolders with color management files in GMG ColorServer via remote access. Web-
Connect also follows the client/server model, but as the client only needs a web browser to access GMG
ColorServer hotfolders, there is no installation required from the client side.

Client-server configuration: Installation on two separate computers (server, client), as shown in the
table below.

Workstation Installation

Server GMG ColorServer, GMG ConnectServer, GMG WebConnect

Client GMG SmartProfiler

Note The number of client programs you can install on different computers depends on the purchased
license. All client computers must have access to the server with Full Control permissions.

Note GMG SmartProfiler licenses are managed by GMG ConnectServer. You need to install GMG Con-
nectServer on the same computer as GMG ColorServer. Otherwise, it will not be possible to run the client
software.

3.2 Before You Install

To ensure a safe installation, please check the following list before starting the process.

Check the system requirements for the software you want to install.

Make sure a valid license required for the software version you want to install is available on the tar-
get computer.

Unplug all measuring devices connected to the computer (if any). Otherwise, device drivers will not
be properly installed.

Make sure you are logged on as a user with full administrator rights.
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Make sure no Microsoft system updates are running in the background. This could lead to an instal-
lation failure.

3.3 Additional Requirements under Windows 7 and Windows Vista

When using Windows 7 or Windows Vista, it is required to deactivate the User Account Control before
installing GMG ColorServer. Otherwise, software modules will not be recognized correctly (you can
check this under Help > Info in GMG ColorServer) and GMG ColorServer will not operate properly.

How to deactivate the User Account Control on Windows 7

1. Open the Control Panel, click User Accounts.

2. Click Change User Account Control settings.

3. Move the slider to the Never notify position, and then click OK.

4. Restart the computer before installing GMG ColorServer.

How to deactivate the User Account Control on Windows Vista

1. Open the Control Panel, click User Accounts.

2. Click Turn User Account Control on or off.

3. Deselect the User Account Control (UAC).

4. Restart the computer before installing GMG ColorServer.

3.4 Server Installation

GMG ColorServer is the central color management module of GMG ColorServer Suite. Install the module
on a central server that can be accessed from all clients in the network.

GMG ColorServer requires a USB dongle with a license key.

For maximum performance, we recommend the hardware drive configuration as described in the following
chapters.

Note The folder configuration used by the software is defined when creating a new printer–medium com-
bination in GMG SmartProfiler.

See also:

l "Recommended Hardware Configuration" on page 15

3.4.1 Setting Up the Computer

We recommend the program to be run on a computer meeting the following requirements to ensure the
maximum performance from GMG ColorServer.

System requirements: Intel® Core™ 2 Quad, Q6600 or similar, 2.4 GHz, 2 x 4 MB Level 2 (L2) cache, 4
GB RAM, 750 GB - 10.000 U/min hard disk drive with at least 15 GB free disk space

Hardware components: Video card (DVI, supporting DirectX 9c), enabled Direct 3D acceleration, updated
driver (not Windows default driver), for example, NVIDIA® GeForce 8600 GT; minimum screen resolution
1024 x 768 px, 32 bit color depth

Operating system:

Windows 7 (32-bit/64-bit version)

Windows Vista Service Pack 1 or later (32-bit/64-bit version)

Windows XP Professional Service Pack 3 or later

Windows Server 2008

Windows Server 2003 Service Pack 2 or later

NTFS file system only (FAT32 is not supported)
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Note The spectral color chart reader iCColor (X-Rite) is not supported in the 64-bit version of GMG Smart-
Profiler.

Software components:

Microsoft Internet Explorer 6.0 or higher

Direct X 9c or higher (required for the GMG GamutViewer feature in GMG ProfileEditor)

User rights: Power User, under Windows Vista: Administrator (Full administrator rights are always
required for installation.)

3.4.2 Recommended Hardware Configuration

For maximum processing performance, we recommend the following hardware configuration with three
separate disk drives on the same computer, as described in the following.

Note A noticeable performance increase can be achieved only with separate physical disk drives, not with
separate partitions on the same disk drive.

Disk drive with the GMG ColorServer installation

Disk drive for input data (Input Folders)

Disk drive for output data (Output Folders)

See also:

3.4.3 Installing GMG ColorServer

Note The GMG ColorServer Suite installer offers an update functionality. If you have already installed
GMG ColorServer4.7 or later, you do not need to uninstall an existing version before installing the new
version. If you have installed an earlier version, you will need to uninstall an existing version before
installing the new version.

GMG ColorProof o4, DotProof o4, FlexoProof o4

If you have a dongle with a combined license for GMG ColorServer and GMG ColorProof o4, DotProof o4,
or FlexoProof o4, you will not be able to use proof printers anymore after installing the GMG ColorServer
4.7 setup. This functionality is only supported up to version 4.6.

How to uninstall the previous version

Existing hotfolder configurations or application data from the user are not changed by the installer. Still, it
is recommended to make an environment backup to save all workflows and settings before uninstalling
the software to avoid any potential data loss.

1. Start your currently installed version of GMG ColorServer.

2. On the Options menu, point to Environment Backup, and click Create.

3. After the Environment Backup has been successfully created, close all GMG applications.

4. Uninstall GMG ColorServer from the Windows Control Panel (Start > Control Panel > Programs and
Features). Do not delete the main program folder (default folder for version 4.6 or lower: c:\C-
olorproof\) manually before the new installation as the folder contains all printer calibrations, pro-
files, and other system files and application data related to the software.

5. After the uninstall operation is complete, restart the computer.

How to install the new version

Note Even if the installer appears to be unresponsive, it is still working in the background. Do not cancel
the installation, end the process, or restart the computer until the installation is finished.
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1. For a successful installation of device drivers, unplug all spectrophotometers connected to the com-
puter.

2. You can install the program directly from the purchased DVD.

3. If you downloaded the program from the GMG website, copy the GMG-ColorServerSuite_4.7.x.x._
32bit.zip file, "4.7.x.x" being a placeholder for the current build number, (or the 64-bit version) into a
local directory on the computer you want to install the program on.

4. Extract all compressed files and double-click the GMG-ColorServerSuite_4.7.x.x._32bit.exe file (or
the 64-bit version) to start the installation.

5. Follow the instructions of the installation assistant. (If upgrading from an earlier version than 4.7,
please install the program to a different folder than the one you installed the previous version to.)

6. Under Setup Type, you can select the Custom option if you want to install only the main components
required for a specific program.

7. Deselect the features you do not want to install on the computer.

8. If you want to run GMG SmartProfiler on a remote client and not on the same computer as GMG Col-
orServer, select only the Server features (i. e. GMG ColorServer, GMG ColorServer Connector, and
GMG ConnectServer) for the installation on the server computer and select only the Client features
(i. e. GMG SmartProfiler) for the installation on the client computer.

9. Please wait while the installer is running.
The installer needs to extract the installation package, install the program, and copy all application
data to the hard disk. These actions may take a while. The installer might appear unresponsive dur-
ing the installation. This is considered to be normal behavior and does not impair the installation suc-
cess.

10. Restart the computer when you are prompted to do so.
The installation procedure will be automatically resumed after the restart.

11. The installation assistant will inform you when the installation is complete. Click the Finish button to
exit the wizard.

3.4.4 Software License

License Information

Features available in the software bundle are controlled by the license information on the connected USB
dongle. Please make sure that you have all licenses required for the actions you want to perform with the
software.

For example, trial or temporary program versions can be limited either by the number of actions the user
can perform or by an expiration time.

Licenses can be updated via the software. For more information on available license packages, please con-
tact your local dealer.

Please keep the license information and serial number at hand when contacting the support.

How to check the currently available licenses

1. Start the main GMG ColorServer application.

2. On the Help menu, click License Update.
A list with all licenses installed on the connected USB dongle is displayed.

3.5 Client Installation

GMG ColorServer can be accessed by multiple clients (GMG SmartProfiler installations) in the network.
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3.5.1 Setting Up the Computer

We recommend the program to be run on a computer meeting the following requirements to ensure the
maximum performance from GMG ColorServer.

System requirements: Intel® Core™ 2 Quad, Q6600 or similar, 2.4 GHz, 2 x 4 MB Level 2 (L2) cache, 4
GB RAM, 750 GB - 10.000 U/min hard disk drive with at least 15 GB free disk space

Hardware components: Video card (DVI, supporting DirectX 9c), enabled Direct 3D acceleration, updated
driver (not Windows default driver), for example, NVIDIA® GeForce 8600 GT; minimum screen resolution
1024 x 768 px, 32 bit color depth

Operating system:

Windows 7 (32-bit/64-bit version)

Windows Vista Service Pack 1 or later (32-bit/64-bit version)

Windows XP Professional Service Pack 3 or later

Windows Server 2008

Windows Server 2003 Service Pack 2 or later

NTFS file system only (FAT32 is not supported)

Note The spectral color chart reader iCColor (X-Rite) is not supported in the 64-bit version of GMG Smart-
Profiler.

Software components:

Microsoft Internet Explorer 6.0 or higher

Direct X 9c or higher (required for the GMG GamutViewer feature in GMG ProfileEditor)

User rights: Power User, under Windows Vista: Administrator (Full administrator rights are always
required for installation.)

3.5.2 Installing GMG SmartProfiler

Note The GMG ColorServer Suite installer offers an update functionality. If you have already installed
GMG SmartProfiler1.5 or later, you do not need to uninstall an existing version before installing the new
version. If you have installed an earlier version, you will need to uninstall an existing version before
installing the new version.

How to install the new version

Note The system component GMG ColorServer Connector is required for proper operation of GMG Smart-
Profiler and must be installed on the same computer where GMG ColorServer is installed.

Note Even if the installer appears to be unresponsive, it is still working in the background. Do not cancel
the installation, end the process, or restart the computer until the installation is finished.

1. For a successful installation of device drivers, unplug all spectrophotometers connected to the com-
puter.

2. You can install the program directly from the purchased DVD.

3. If you downloaded the program from the GMG website, copy the GMG-ColorServerSuite_4.7.x.x._
32bit.zip file, "4.7.x.x" being a placeholder for the current build number, (or the 64-bit version) into a
local directory on the computer you want to install the program on.

4. Extract all compressed files and double-click the GMG-ColorServerSuite_4.7.x.x._32bit.exe file (or
the 64-bit version) to start the installation.
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5. Follow the instructions of the installation assistant. (If upgrading from an earlier version than 4.7,
please install the program to a different folder than the one you installed the previous version to.)

6. Deselect all Server features. Make sure all Client features are selected. Click Next.

7. Please wait while the installer is running.
The installer needs to extract the installation package, install the program, and copy all application
data to the hard disk. These actions may take a while. The installer might appear unresponsive dur-
ing the installation. This is considered to be normal behavior and does not impair the installation suc-
cess.

8. Restart the computer when you are prompted to do so.
The installation procedure will be automatically resumed after the restart.

9. The installation assistant will inform you when the installation is complete. Click the Finish button to
exit the wizard.

3.5.3 Network Settings on the Client

GMG SmartProfiler and GMG ColorServer talk to each other via a central server running in the back-
ground. This server is installed by default on the same computer as GMG ColorServer.

If you want to run GMG SmartProfiler as a client, remote controlling GMG ColorServer via the network,
you need to enter the IP address of the computer on which GMG ColorServer is installed.

If you want to run GMG SmartProfiler on the same computer as GMG ColorServer, enter "localhost"
instead of an IP address.

How to connect GMG SmartProfiler to the server

1. On the Options menu, click Network Settings.

2. Enter the IP address of the computer on which GMG ColorServer is installed as the Server Address
and enter the Server Port.

3. Click the Test Connection button to check whether the connection can be established.
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4. Server Configuration (from a Client)

4.1 Possible Applications

4.1.1 Standardizing Print Production (CMYK Data)

For conventional printing methods, internationally binding standards such as ISO Coated v2 (39L) already
exist. With GMG ColorServer Suite, you can easily use any one standard as a reference color space for
standardizing your print production. In a mixed production environment, standardizing the production adds
the bonus that colors will be matching as closely as technically possible on different output devices and
when using different printing conditions.

Tip Choose this profiling mode if you want to standardize your print results according to a CMYK reference
color space.

Supported print standards are:

Offset (PSO)

Newspaper

PSR

GRACoL

SWOP

3DAP

JMPA

JPC

PPA

OK Required steps See also

Create a hotfolder in GMG SmartProfiler. On the Hotfolder page, select the target
printing condition as Normalizing Color Space.

"Defining the Settings for the Printer–
Medium Combination" on page 22

Create a profile in GMG SmartProfiler. (The Normalizing Color Space will be auto-
matically used as Source Color Space (Target Values).)

"Next Steps" on page 24

4.1.2 Photo Printing (RGB Data)

For photographic print production, it is considered best practice to print RGB images directly from their
original color space. This way, you will be able to print bright and colorful images without quality loss. If
images would be normalized to CMYK, the large source color space would be significantly reduced.

With the right settings as explained in the following, GMG ColorServer Suite will transform RGB images
directly into the color space of your printer.

Tip Choose this profiling mode if you want an excellent reproduction of RGB images, without stand-
ardization to a CMYK reference color space.

Note GMG SmartProfiler does not support an RGB-to-RGB normalization. If you want to do this, you will
need to modify the hotfolder in GMG ColorServer after the profiling has been finalized. Otherwise, you
will need to make sure that all input documents are using the correct RGB input color space to achieve
color matching results.

OK Required steps See also

Create a hotfolder in GMG SmartProfiler. On the Hotfolder page, select the
option PDF Input Color Space.

"Defining the Settings for the Printer–Medium
Combination" on page 22
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OK Required steps See also

Create a profile in GMG SmartProfiler. On the Profile page, select an RGB color
space as Source Color Space (Target Values).

"Next Steps" on page 24

4.2 Starting GMG SmartProfiler

Note The GMG Connect Service, which must always run in the background on the computer you installed
GMG ColorServer on, might not be compatible with standard firewall programs. Therefore, you might need
to deactivate your firewall when running GMG SmartProfiler.

You can use GMG SmartProfiler to configure GMG ColorServer. The two separate programs do not need to
be installed on the same computer; you can access GMG ColorServer via the network.

GMG SmartProfiler can be started by double-clicking the program icon on the Windows desktop or from
the Start menu.

4.3 Start Page

GMG SmartProfiler helps you to create printer calibrations and color profiles for GMG ColorServer hot-
folders. You can also set up new hotfolders.

Generally, you will start with creating a new printer–medium combination. GMG SmartProfiler will
guide you through setting up a hotfolder (you can also use an existing hotfolder) and creating a
printer calibration (optional) and profile for this hotfolder. For creating the profile, you will be for-
warded to the Create New Profile mode.

After creating a printer-medium combination, you can use the Recalibrate mode to update the
printer calibration on a regular basis.

Create New Profile guides you through the process of creating a new MX4 color profile for the
selected hotfolder.

Fig. 3 Start page.
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Click the button or link of the mode you want to use (1). GMG SmartProfiler will switch to the selected
mode, taking you through the process step by step. Click the info buttons for further information (2).
If you save an ongoing process as a CSW file, you can load the file from the File menu and resume the
process.
Press F1 on the keyboard to show the Help.

4.4 About "Create New Printer–Medium Combination"

Click the Create New Printer-Medium Combination button to create a new hotfolder with a printer cal-
ibration (MX3) and a color profile (MX4) supporting a specific printing condition and print medium.

GMG SmartProfiler will switch to Create New Printer-Medium Combination mode, taking you through the
process step by step. Creating a printer-medium combination includes the following steps.

OK Required steps

Create a hotfolder.

Create a printer calibration file.

Create a color profile.

The GMG ColorServer technology is based on DeviceLink MX profiles.

A DeviceLink profile is designed for color transformations from a defined input color space to a defined
output color space.

DeviceLink color transformations generally provide a higher quality and an optimized handling of the
black channel.

In contrast, ICC profiles use a device-independent intermediate color space, usually Lab, to link two
device-dependent color spaces.

Therefore, you will need to set up a separate printer–medium combination in the GMG ColorServer sys-
tem for each printer and medium you want to use.

Printer calibration file

A printer calibration file is used for compensating undesired printer deviations caused by varying envi-
ronment conditions.

A printer calibration file is valid only for the printer–medium combination it has been created for. You will
need a different printer calibration file for each printer–medium combination you want to use.

Color profile

An MX4 Digital Print Production profile is used to transform the print standard color space, for example,
ISO Coated v2 (39L), into the printer color space.

You will need a different color profile for each printer–medium combination you want to use.

If you want to support multiple print standards, you will need a separate hotfolder with its own color pro-
file for each print standard and for each printer–medium combination.

4.4.1 Starting the Process to Create a New Printer–Medium Combination

The first step is to create a hotfolder for each printer-medium combination you might have.

How to start the process

1. Start GMG SmartProfiler from the Windows Start Menu.
The start screen of the program shows all available processes.

2. Click the button or link corresponding to the Create New Printer–Medium Combination mode.
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Fig. 4 Starting the Create New Printer–Medium Combination mode.

Click the button or link corresponding to the Create New Printer–Medium Combination mode. GMG
SmartProfiler will switch to the selected mode, taking you through the process step by step.
If you need further information at any point during the process, press F1 on the keyboard to show the Help.

4.4.2 Defining the Settings for the Printer–Medium Combination

For each printer–medium combination (including printer parameters such as the print mode and the ink
type), you will need to create a separate hotfolder, profiled specifically for the printer–medium com-
bination.

If the Printing Method list does not show the printer you are using, select a generic default printer most
closely matching your printing system.

How to set up a hotfolder

1. Type any name into the Hotfolder Name box (1).

2. Under Normalizing Color Space (2), select the print standard to which you want to convert all input
data, for example, ISO Coated v2 (39L). Select PDF Input Color Space for photo printing without
standardization.

3. Under Printing Method (3), select the printer model for which you want to create the hotfolder.

4. Select the Ink Type, Print Medium, and Print Mode (4) for which you want to create the hotfolder.
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Fig. 5 Creating a new printer–medium combination.

The screen shot shows the basic hotfolder parameters as described in the preceding instructions.

4.4.3 Defining the Output Folder

Processed PDFs that are ready for printing are saved to the output folder of the hotfolder.

You will need to connect the output folder to your printer frontend. This can be done by selecting the input
folder of the RIP as output folder for GMG ColorServer.

Tip If you do not have configured your RIP yet, you can also create GMG ColorServer hotfolders first and
then configure the RIP. However, you will need a working connection to the printer frontend before you
will be able to print any test charts.

Test charts from GMG SmartProfiler and all documents you send to the input folder of GMG ColorServer
later are thus automatically printed on the correct printer.

Note GMG ColorServer Suite must have full access (read and write permissions) to this folder.

If you have already configured the frontend RIP

Under Output Folder, click the browse button and select the input folder of the RIP.

If you do not have an input folder for the RIP yet

Under Output Folder, enter any folder path accessible to the frontend RIP.

If the frontend RIP has full access to the computer on which GMG ColorServer is installed, you can
leave the suggested default path as it is.
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Fig. 6 Creating a hotfolder, defining an output folder.

On the left side, you can modify the predefined folder paths if required. On the right side, you see a "pre-
view" of the folder paths on the target GMG ColorServer system. The left side shows only the part of the
folder path you can edit. As an alternative, you can also use the browse box to select a shared folder on
the network.

See also:

l "Printing Documents" on page 27

4.5 Next Steps

4.5.1 Creating a printer calibration file

If you are using a printer calibration file (Settings > Printer Calibration > Create Printer Calibration
option), GMG SmartProfiler will ask you to connect a measuring device to your computer. A connected
measuring device will be automatically recognized by the program.

You can then proceed with the creation of a printer calibration file as instructed by GMG SmartProfiler.

4.5.2 Creating a profile

In the next step, you will create a profile for your printer–medium combination. (A profile is always
required, regardless whether you are using a printer calibration or not.)

If you have opted for standardizing your print production, the source color space is already defined
by the Normalizing Color Space. You can select the separation mode and additional profiling param-
eters.

If you want to use multiple print standards, repeat the procedure for all print standards you might
have.

For photo printing of RGB documents, you will need to select an RGB color space as Source Color
Space (Target Values) as shown in the following screenshot (see figure "Fig. 7" on the facing page) .

Repeat the procedure for all RGB color spaces you want to support.
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Fig. 7 RGB source color space for profiling.

In the example shown in the screenshot, the standard color space "Adobe RGB (1998)" will be used as
input color space. This means, all documents must be converted to the "Adobe RGB (1998)" color space
before sending them to the hotfolder. If the color space you are using is not listed, you can click the
browse button and select a custom RGB ICC profile. You can select an RGB source color space here:
Create New Profile > Settings > Profile.

4.5.3 Finalizing and starting the print production

After the profiling process has been finalized, the hotfolder will be ready to use. You can then start
with the print production from the GMG ColorServer system.

Repeat the procedure (creating a hotfolder, printer calibration file, and profile) for all printer–medium
combinations you might have.

Example:

For example, if you want to support a Roland VP-540i together with a semimatte print medium, supporting
both ISO Coated v2 (39L) and GRACoL, you will need two separate hotfolders, with two different Nor-
malizing Color Spaces:

Roland VP-540i, on semimatte, ISO Coated v2 (39L)

Roland VP-540i, on semimatte, GRACoL

4.6 Where to Find Further Information

For further information on the hotfolder configuration or profiling procedure, please see the referenced doc-
uments.

Further information:

l GMG SmartProfiler Help

l GMG SmartProfiler User Manual:
GMG-SmartProfiler_Manual_en.pdf
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5. PDF Production (from the Server)

5.1 Starting the Software

How to start GMG ColorServer

1. Connect the license dongle to a USB port.

2. Double-click the GMG ColorServer program icon on the Windows desktop or click GMG ColorServer
on the Windows Start menu.
The program verifies the license information on the dongle and then starts the application auto-
matically.

3. If you had a previous version of GMG ColorServer installed and have an environment backup, you
can restore it now. On the Options menu, point to Environment Backup, and click Restore.

5.2 Program Overview

Fig. 8 Main program window of GMG ColorServer.

The Overview window provides an overview on your hotfolder configuration (1). You can double-click a
hotfolder to show the processing settings. You can use a hotfolder command from the context menu. You
can select a hotfolder with the mouse to create a manual job. (The Printer configuration is important only
if you are using Image Hotfolders. Image Hotfolders require a ColorServer printer.)
On the right pane, you can see all jobs generated by the selected hotfolder (2). You can select a job and
use a job command from the context menu, for example, to manually start printing.
The Output Log window (3) shows a list with all processed jobs. (You can activate the Output Log window
from the Options menu.)

See also:

l "Hotfolder List View" on page 28
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5.3 Printing Documents

Fig. 9 Automated print workflow with GMG ColorServer.

In GMG ColorServer, separate hotfolders can be used for image and for PDF processing (1). You can also
use PDF hotfolders to create PDFs from image data.
All documents undergo an automated color management process in GMG ColorServer. No further color
management is required.
The output folders (2), where the color managed documents are saved, are used as input folders for the
external printer frontend, which is usually either a RIP or a workflow system. The external system will
only rasterize (RIP) the documents (3) and sent the rasterized documents to the printer (4). Often the fron-
tend also supports nesting and tiling for an optimized paper usage.
You can either use the printer linearization from the external system or create a new printer linearization
in GMG SmartProfiler.

See also:

l "Defining the Output Folder" on page 23

5.3.1 Choosing a Printer–Medium Combination

GMG SmartProfiler uses the advantages of DeviceLink MX color profiles. This means that a profile will be
created specifically for each printer–medium combination.

Each GMG ColorServer hotfolder represents such a printer–medium combination, that is, a specific device
together with a specific print medium such as a gloss or semimatte media type.

By choosing one of the hotfolders from the list in GMG ColorServer, you decide which printer and print
medium you want to use for printing.

There are two methods for printing a document:

Place an input file into the input folder defined in the hotfolder settings. This method has the advan-
tage that no direct user interaction with the GMG ColorServer program is required. You can access
the input folder from any computer in the network.

In the Overview list in GMG ColorServer, select the hotfolder you want to use and create a manual
job.

Processed files will be sent to the output folder defined in the hotfolder settings.

If you have connected the output folder to the printer frontend, printing will start automatically.

Otherwise, you will need to send output files manually to the printer.



5. PDF Production (from the Server)

28 / 32

Fig. 10 Choosing a printer.

For example, you could have three printer–medium combinations: For example, hotfolder A and B could
represent the same printer "X" with two different media types gloss and semimatte, whereas hotfolder C rep-
resents a second printer "Y". If you want to print a document on printer "X", semimatte, you need to copy
the document into hotfolder B.

Note The printer calibration file and digital production profile used in a hotfolder are valid only for the
printer–medium configuration they have been created for. If you want to change the printer or use a new
print medium, you need to create a new printer–medium combination first. Printing an output file on a dif-
ferent printer or medium will lead to unpredictable color results.

5.3.2 Hotfolder List View

Selecting a hotfolder

A hotfolder can be selected in the list with the mouse or by pressing the ARROW UP or DOWN key. A
selected hotfolder or workflow is highlighted by a different border and background color.

When a hotfolder from the left window frame is marked by using the mouse, the window on the right will
show the dedicated images or PDF jobs. Selecting such an image, the lower window will display the asso-
ciated job. Selecting the PDF job, the lower window displays the associated PDF document properties.

Hotfolder commands

Hotfolder commands such as editing or creating a manual job can be selected from the Hotfolder menu or
from the context menu (which appears when you right-click on a hotfolder) and are applied to the selected
item.

The command Hold Images, which may be selected from the context menu by right-clicking on a hot-
folder, puts the automatic processing of jobs by the hotfolder on hold. New files will still be recognized in
the hotfolder and will be added to the file list in the hotfolder. These new documents will remain in status
Hold Images until the command Hold Images is switched off again by the user.
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Fig. 11 Hotfolder put on hold.

As you can see in the screen shot, jobs have been created from all PDFs recognized by the hotfolder. Jobs
are in status on hold as long as the hotfolder is on hold (indicated by the blue Hold icon). After activating
the hotfolder, you need to manually start the processing of each job by using the Print command.

Job commands

Right-clicking on an image or PDF job opens the context menu. There you are able to Print or Delete an
image or PDF job, or to show a Preview.

Fig. 12 Start processing a job on hold.

On the job context menu, click Print to start the processing of jobs on hold.

5.4 Where to Find Further Information

Your hotfolder configuration is now ready to use. Simply drop PDFs you want to process into the hotfolder
or create a manual job. For further information on how to use the software and adapt it to your needs,
please consult the Help from within the GMG ColorServer PDF Hotfolder dialog box or the following
PDFs.

Further information:

l GMG ColorServer User Manual:
GMG-ColorServer_PDF-to-PDF_Manual_en.pdf
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6. Quality Control (from a Client)

6.1 Recalibration

A regular printer calibration ensures a consistent representation of colors. Undesired printer deviations
caused by varying environment conditions such as temperature and humidity are counterbalanced.

Note All printing systems should be recalibrated on a regular basis.

6.1.1 Starting the Recalibration Process

During the recalibration process, you will print and measure test charts until the measured values are
within the defined tolerances. The printer calibration file linked to the hotfolder will be automatically
updated with optimized values.

Note For the process, you will need a measuring device connected to the computer.

Note Before starting the process, make sure the printer parameters are matching with the hotfolder set-
tings. Make sure the correct print medium is loaded into the printer and all relevant hardware parameters
such as ink type and print mode are correct as well.

How to start the process

1. Start GMG SmartProfiler.
The start screen of the program shows all available processes.

2. Click the button or link corresponding to the Recalibration mode.

3. Select a hotfolder corresponding to the printer–medium combination you want to recalibrate from the
Hotfolder list.

Fig. 13 Starting the Recalibration mode.
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Click the button or link corresponding to the Recalibration mode. GMG SmartProfiler will switch to the
selected mode, taking you through the process step by step.
If you need further information at any point during the process, press F1 on the keyboard to show the Help.




	1. Getting Started
	1.1 About  Quick Start Guide
	1.2 Welcome to GMG ColorServer Suite
	1.2.1 Large Format and Digital Printing
	1.2.2 GMG ColorServer Suite Workflow


	2. Pre-check of the Printing System
	2.0.1 How to perform the pre-check
	2.1 Frontend Requirements
	2.2 Visual Evaluation of the Print Quality
	2.2.1 Where to find the test chart

	2.3 Digital Printers
	2.4 Large Format Printers
	2.4.1 4c Gray
	2.4.2 Gradations with pure colors, plus an additional color
	2.4.3 Gradations with pure colors, without an additional color.


	3. Program Installation
	3.1 Installation Overview
	3.1.1 Client/Server configuration possibilities

	3.2 Before You Install
	3.3 Additional Requirements under Windows 7 and Windows Vista
	3.4 Server Installation
	3.4.1 Setting Up the Computer
	3.4.2 Recommended Hardware Configuration
	3.4.3 Installing GMG ColorServer
	3.4.4 Software License

	3.5 Client Installation
	3.5.1 Setting Up the Computer
	3.5.2 Installing GMG SmartProfiler
	3.5.3 Network Settings on the Client


	4. Server Configuration (from a Client)
	4.1 Possible Applications
	4.1.1 Standardizing Print Production (CMYK Data)
	4.1.2 Photo Printing (RGB Data)

	4.2 Starting GMG SmartProfiler
	4.3 Start Page
	4.4 About "Create New Printer–Medium Combination"
	4.4.1 Starting the Process to Create a New Printer–Medium Combination
	4.4.2 Defining the Settings for the Printer–Medium Combination
	4.4.3 Defining the Output Folder

	4.5 Next Steps
	4.5.1 Creating a printer calibration file
	4.5.2 Creating a profile
	4.5.3 Finalizing and starting the print production

	4.6 Where to Find Further Information

	5. PDF Production (from the Server)
	5.1 Starting the Software
	5.2 Program Overview
	5.3 Printing Documents
	5.3.1 Choosing a Printer–Medium Combination
	5.3.2 Hotfolder List View

	5.4 Where to Find Further Information

	6. Quality Control (from a Client)
	6.1 Recalibration
	6.1.1 Starting the Recalibration Process



